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Location: State of Hesse

Roughly at the geographical center of Germany

About 6.3 million residents

Hesse's largest city: Frankfurt am Main
= Hesse's economic powerhouse: the Rhine-Main area

Lots of options for interesting day trips:
e Frankfurt, Wiesbaden, Marburg, Kassel, Darmstadt etc.
e the Taunus uplands, the Rheingau, the Bergstralle etc.

RheinMain University © Prof. Dr. Stephan Bohm
of Applied Sciences 3



Center of Advanced E-Business Studies

f“fmﬁm

MISSION STATEMENT EXPERTISE ABOUT US RESEARCH TEACHING

= A -
il e

G eusans

A /
Das CAEBUS-Team

NEWS

Mission Statement

The mission of Center for Advanced E-Business Studies (CAEBUS) is to deveiop innovative and Call for Papers - CAEBUS Puplication
sustainable e-business models and solutions in line with economic and regulatory frameworks.
The center is committed to providing these solutions through in depth studies of consumer CAERUS Ph.D Canaidate took partn the
needs, cultural requirements, and conditions for economic efficiency. CAEBUS defines 11th International Conference on Mobile
roadmaps for the successful impiementation of E-business solutions in accordance with Learning 2015 Doctoral Consortium

organizational structures and business processes.
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Please contact us if you like to cooperate! (www.caebus.de, stephan.boehm@hs-rm.de)
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History of Mobile Apps

Mobile applications are already offered a longer time — but only the app
store concept was the breakthrough.

o/Tools
_ B

Application manager ::}

Press £, and select Applications > App. mgr.. You can
install two types of applications and software to your
device:

* J2ME™ applications based on Java™ technology with
the extension .jad or .jar ( i)

* Other applications and software suitable for the
Symbian operating system (%3 ). The installation files
have the sis extension. Only install software
specifically designed for your Nokia N95. Software
providers will often refer to the official model number
of this product: the Nokia N95-1.

Installation files may be transferred to your device from a
compatible computer, downloaded during browsing, or
sent to you in a multimedia message, as an e-mail
attachment, or using Bluetooth connectivity or infrared.
You can use Nokia Application Installer in Nokia Nseries PC
Suite to install an application to your device. If you use
Microsoft Windows Explorer to transfer a file, save the file
to a compatible memory card (local disk).

Install applications and s

f% indicates a sisapplication, g, a
that the application is not fully install
application is installed on the memor

G Important: Only install and ust
other software from trusted sources,
that are Symbian Signed or have passt
testing.
Before installation, note the followin
* To view the application type, vers
supplier or manufacturer of the a|
Options > View details.
To display the security certificate
application, in Certificates, selecl
‘Certificate management’, p. 123.
* |fyou install a file that contains a
an existing application, you can o
original application if you have the
file or a full back-up copy of the t

The jar file is required for installing Java applications.
If it is missing, the device may ask you to download it.
If there is no access point defined for the application,
you are asked to select one. When you are downloading
the _jar file, you may need to enter a user name and
password to access the server. You obtain these from
the supplier or manufacturer of the application.

To locate an installation file, press £ , and select
Applications > App. mgr.. Alternatively, search the
device memory or a compatible memory card (if
inserted) in File mgr., or open a message in
Messaging > Inbox that contains an installation file.
In App. mgr., select Options > Install. In other
applications, scroll to the installation file, and press @
to start the installation.

During installation, the device shows information
about the progress of the installation. If you are
installing an application without a digital signature or
certification, the device displays a warning. Continue
installation only if you are sure of the origin and
contents of the application.

(P —

NOKIA
NS5

. Henu

.

s

=

Gallery

package. To restore the original ap
application, and install the applici
original installation file or the bac

To start an installed application, locate it in the menu, and
press @ . If the application does not have a default folder
defined, it is installed in the Applications folder.

To see which software packages are installed or removed

1 and when, select Options > View log.

Source: http://ndsl.nokia.com/phones/files/guides/Nokia N95-1 UG en.pdf
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Mobile Application Defined

Mobile App/Application:

Application software to run on mobile devices, such

as Smartphones, with which the functionality given

by hardware and operating software can be applied
to solve user-specific problems.

Typically, Mobile Apps consist of programs and data
that will be installed by the end users themselves
to the devices and thus are also an important
element of handset personalization.

Source of pictures:
http://tweakyourbiz.com
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App Stores

The major app stores now offer quite a vast number of applications.

\eJ App Store > 1.400.000 Apps

B Google play > 1.600.000 Apps
£ Windows Phone
Marketplace > 3500804pps

Sourcen: Unternehmenswebsites; Source of pictures: http://blog.mobiles.co.uk/app-reviews/how-many-apps-2012/
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Advanced Mobile Apps

Many Mobile Apps establish a direct relation to the real mobile usage context
in other word the provide a "Real World Connection".

iPhone Screenshots
iPhone Screenshots
‘ DRUMSTICKS ) %
‘ Golf Coach Putter Acceleration
b \ »

Putter Acceleration

iPhone Screenshots

/ =

T \&/_! R barcoo
iPhone Screenshots =9 -l ace devic:
r How do you want to cook @2B3@The perfect steak for me1 Screenshots »
your steak?

How thick is your steak? 0.79 in &)

L Back P T?; | Continue j
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Augmented Service Offerings

Augmented Service Offerings provide functionalities that are based on an

access to other connected devices.

Die WiFi Personenwaage
o

lhre Gewichtskurve im Taschenformat

Videoprasentation

i )

Und Ihrem Computer

"

Wy /
{65 oF "
’ N e routatote & Bness i on)
P o W \ct':;‘:me“ Familie
1 v ercon s I A e, 38 johme
age an mej natischy vonmoiner — A i U

e an
Nichis 21 taeher 1y C Ubertra
ch aeni
Valaria, 34 japye SB5SLSBhY prakdigchr

¥/ 5

Source: http://www.withings.de/de/waage, http://www.igrillinc.com/
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M H FREE SHIPPING
PA_/S I rl Now you're cooking! Lo P onCicoce BT

Don't miss out - Order Now!

About the iGrill Purchase iGrill Support iGrill University About iDevices

AV‘ able in our Online S&gge!

Get FREE shipping with promo code FALL12!

“The future of grilling has arrived”- Fortune

Prof. Dr. Stephan B6hm
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Next Generation Mobile Apps: Wearable Devices

Potential disruptive technology

= Social impact (privacy)

= Lifestyle product (,,Cool or Creepy”)
= New user experience/usability

= New areas of application
(in both — business and consumer
segments)

= New eco system

“We removed everything that wasn't absolutely essential.”

Isabelle Olsson, senior industrial designer, Google Glass

Sources: Google, http://www.smh.com.au/digital-life/digital-life-news/google-glass-wasnt-always-so-slick-20130521-2jxgv.html

. . . : Prof. Dr. Stephan B6hm
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Next Generation Mobile Apps: Mobile Device Trends

Gear, Samsung

= New interaction/usage (Smartwatch)

scenarios

= Screen independent
interaction

MYO, Thalmiclabs
(Muscle Activities)

= Non-intrusiveness

Muse, Interaxon
= Smartphone as a hub (Brain Sensing)

= |ncreasing device il N
fragmentation

4

Fokus Today: Simple Apps for Smartphones

Quellen: https://www.thalmic.com/de/myo/, http://www.interaxon.ca/muse/

RheinMain University © Prof. Dr. Stephan Bohm
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Consumerisation of IT

Driven by the success of mobile apps in the consumer segments those concepts
are conguering the corporate context ("consumerisation of IT").

sap . oser oo
The Best Run Businesses Run SAP Getting Started Contact

SAP Mobile Apps Learn Solutions
BN \- e |13 8
ANY TIME. ANYWHERE. ,

tJE |4
Any device secure access.

UserLogin

SOLUTIONS PARTNERS COMPANY RESOURCES NEWS & EVENTS BLOG

.= Featured Apps

) Distribute mobile apps securely acros
| Q enterprise without restricting personal deu& o
LEARNMORE y
SAP Travel SAP CRM SAP SkillScanner SAP
Expense Sales Policyholder StreamWork
Approval Lookup p
) = > For Business For IT Pros AppCentral Trial
| oo Unlock enterprise resources Unleash mobile apps Get started now
= < ) 5 sovanta
| m
SAP Leave SAP Retail Market SAP Sales SAP SAP HCM iPeople Latest News & Blog What People are Saying Customer Insights
Request Execution Intelligence Order BusinessObjects Manager News sl Te CMO Owns thetlE o o
Notification Explorer Insight Bodoes e “Security fears caused 75% of "‘w
by Nikfar Khaleeli On Monday, | read a enterprisestodelay rollingout | cooime s mearine
very interesting article titled “The mobile apps at one time or Ag
- devalued... continue reading crother® i i
Mi ectric will disc
- Kelton Research, 2011 they are using AppCentral to leverage

Source: http://ecohub.sap.com/store/mobility/ et

Source: http://www.appcentral.com/

© Prof. Dr. Stephan B6hm
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Consumer vs. Business App Environments

*

Business

Time Horizon

Value Add

Complexity

Security

Distribution

Usage/
Distribution

RheinMain University
of Applied Sciences

Short term
,Fire-and-Forget“/Updates

Multidimensional (e.g.
Enjoyment)

Rather low
(,,Stand-alone®)

,Hygiene factor”

(except banking/payment)
Epidemic/

Public App Stores

Self-determined/
attract and retain customers

Long term
Versioning/Releases

Measurable contribution to
corporate success

Rather high
(,Backend integration®)

Business critical
(,,condicio sine qua non”)

Rollout (planned)/
Enterprise App Store

Predetermined/
create acceptance

Prof. Dr. Stephan B6hm
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Strategic Alignment and Dimensions of Mobile App Projects

F .

Strategic Alignment Project Dimensions

Reactive
(Maintain user base/shift desktop to mobile)

Expansive
(Extension of user base/existing customer groups)

Innovative
(Development of new customer groups)

Operationally

(For example, cost savings)

Competitive

(e.g. "Copycat"/users of competitors to poach)

Experimental
("Trial balloon", launch & learn approach)

-

RheinMain University
of Applied Sciences

= |ntegration in overall strategy
= Project sponsorship

= Project organization

= Budgeting

=  Technical Realization

= Back-end integration

= Security concept

= Design (Cl / CD specifications)
=  Qutsourcing

= Marketing/distribution

= Success controlling (KPlIs)

© Prof. Dr. Stephan B6hm
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Complexity Drivers of Mobile App Projects

= |nnovativeness established < ” novel
= Functions standardized T ¥ specialized
= User groups homogeneous ” heterogeneous
= Backend connection isolated “ T ” integrated
= Process routine ~ T " ad-hoc
= Stakeholder few “ “many
= Legal requirements unregulated < ” regulated
= Safety requirements low < ” high
= Device platforms few < ¥ many
= Device fragmentation low < ” high
Low complexity, High complexity,
standard software ——— ] customized solutions
“Mobile Apps" ,Mobile Solutions”

RheinMain University © Prof. Dr. Stephan B6hm
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Mobile Apps: Backend vs. Frontend

Fokus Today:
Simple Apps
for Smartphones

Backend

(business processes
and systems)

In most of the cases the app is only the
frontend of a more comprehensive IT solution!

RheinMain University © Prof. Dr. Stephan Bohm
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Mobile App Prototyping

e B B

Mobile App Marketing
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Types of Mobile Apps

Technically, a mobile app can be realized in very different ways.

Mobile Apps in a broader sense
|

Hybrid Native
Technolo Web Page
ay 9 App App
Cross
_ Frameworks,

Development Web editor, plugins etc development (z BSEnlferid

Platform construction (z.B.jQueryj platforms ' éDK)

kit (z.B. PhoneGap)
Coding Web Technologies (HTML5, CSS3, JavaScript) Software

Language (e.g. Java)

Distribution Web App Store
Hardware Usually not possible Widely Fully
Access
Offline , Restricted Fully
Capabilities Online only (Caching) (if no server access required)

RheinMain University Prof. Dr. Stephan B6hm
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Mobile Web Apps

Mobile web apps offer a similar look and feel as native applications, provide
limited offline use and run encapsulated from the hardware in the browser.

€) Ease of development
€) Icon/shortcut possible
0 Easy to publish via a link

Q Operating system independent
(runin "any" browser)

e Always up to date e No sale on App Stores

Q Limited offline-capabilities (only caching
code and content)

€& No access to handset functions such as
camera (localization possible)

Q Poor/limited performance

RheinMain University © Prof. Dr. Stephan B6hm
of Applied Sciences 20



Mobile Web Apps: jQueryMobile

 jQuery

mobile

Demos Download APIDocumentation Themes Resources Blog About

A Touch-Optimized Web Framework

jQuery Mobile is a HTML5-based user interface system
designed to make responsive web sites and apps that are
accessible on all smartphone, tablet and desktop devices.

Seriously cross-platform with HTMLS

jQuery Mobile framework takes the "write less, do more" mantra to
the next level: Instead of writing unique applications for each mobile
device or OS, the j[Query mobile framework allows you to design a
single highly-branded responsive web site or application that will work
on all popular smartphone, tablet, and desktop platforms.

Browser Support

https://iguerymobile.com/

RheinMain University

of Applied Sciences

Contribute

S

Plugins Events Support  jQuery Foundation

Your donations help fund the continued
development and growth of jQuery.

SUPPORT THE PROJECT

Search

Download jQuery Mobile

Custom download

Developer Links

Source Code (GitHub
jQuery Mobile Git (WIP Build)
JavaScript
css
Report an issue
Browser Support
Changelogs
Upgrade Guides

Roadmap

.

On

C + TINGULARJS

by Google

© Prof. Dr. Stephan B6hm
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Hybrid Apps

Hybrid apps combine advantages of web apps and mobile apps allow access
to terminal functions and promise a simple cross-platform portability.

Q Relatively simple development
Q Cross-platform portability
Q Sale on app stores possible

€) Comprehensive access to handset
functions (depending on Framework)

0 Offline capability

Q High dependence on framework
(e.g. for debugging, OS updates)

Q Limited performance

@ Porting requires typically more
comprehensive interventions (e.g. GUI)

Q Dependencies on App Store, and OS
vendors (e.g. app review)

RheinMain University Prof. Dr. Stephan B6hm
of Applied Sciences 22



Hybrid Apps: PhoneGap/PhoneGap Build (Cloud)

*

Easily create apps using the web
technologies you know and love:
HTML, CSS, and JavaScript

PhoneGap is & free and open source framework that allows you to create mobile

apps using standardized web APIs for the platforms you care about

‘ Getting Started Guides »

Adobe PhoneGap Enterprise

Enterprise mobile application development and management across channels
and platforms

© o, L)
— ] I

INTEGRATE CROSS MOBILE APPLICATION ENTERPRISE
CHANNEL MARKETING MANAGEMENT SUPPORT & TRAINING

Getmore info »

The PhoneGap Developer App

Develop locally then see the changes instantly on your mobile device with our

cross-platform app

https://build.phonegap.com/, http://phonegap.com/

RheinMain University
of Applied Sciences
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Native Apps

Native Apps (mobile apps in the narrower sense) are specifically programmed,
compiled, and installed on the device for a specific operating system platform.

€) Comprehensive developer tools
€) Most comprehensive functionality

€) Comprehensive devices access
Q Knowledge in specific programming

€) User experience can be optimized language required

for a specific handset very well
Q Separate development for each operating

0 Very good performance system platform required

Q Most comprehensive commerciality Q Dependencies on App Store, and OS

€) Offline capability vendors (e.g. app review)

Q Device specific adaptation required
(to fully exploit the potential)

RheinMain University Prof. Dr. Stephan B6hm
of Applied Sciences 24



Device Fragmentation (Android)

The large terminal fragmentation in Android devices is a problem which
complicates the development of Android apps.

Device model

GT-13000

Device fragmentation based on the downloads for the software “OpenSignalMaps” (681,900 downloads
in 6 month, 3.992 different handsets, 61.389 downloads by GT-i9100 [Galaxy SII]).

Source: http://opensignal.com/reports/fragmentation.php

RheinMain University © Prof. Dr. Stephan Bohm
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App Development Process

Between the idea to the market launch of an app are various steps that
slightly vary by the specific mobile platform.

Selected Steps of an iPhone App Development

Framework: Software Language: Application Icon,
Cocoa Touch Objective-C Description
Tools: Testing: Screensgots,.
Xcode, Interface iPhone Simulator, K?VV‘{EF S Prlcél,d
Builder, ... Instruments, ... Distribution Bui

Developer iPhone Concept App
Account SDK Definition Marketing
Commercial Functionality, iTunes Connect: Revenue:
Development: Content, Apple Review Team 70% Developer,
Apple Developer User Interface Design, (days up to several 30% Apple
Program an other weeks)
(ab 99 USD/Jahr) Interfaces

RheinMain University © Prof. Dr. Stephan B6hm
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Mobile App Development: Standardized Solutions

Standardized "modular systems” and construction kits are the simplest
solution offered for mobile app development.

AppYou rself Preise ~ Tour  Design Service  Reseller Jonse Support Anmelden

Der App Baukasten - in 3 Schritten zur eigenen App.

Available on th

App Store

& logn german ¥

Produkt Vertrieb Ressourcen [ENeSIEaIERENEIIO)

o Design auswahlen e Inhalt anpassen e App veréffentlichen
Wahlen Sie ein Design, das zu lhrem Mehr als 15 App Bausteine lassen keine Die Komplettiosung fiir Ihre App - AppYourself
Unternehmen passt. Logos, Farben, Wiansche offen. um Neukunden zu gewinnen bietet Innen die Moglichkeit, eine Web App mit ERSTELLEN S I E I H R E APP
Hintergrundbild, Navigationsstil u.v.m. kénnen und bestehende Kunden zu binden. einer nativen App zu kombinieren

Sie ndviduel anpassen. ' MIT NUR WENIGEN KLICKS!

0

KOSTENLOS TESTEN ©)

KEIN ABO ERFORDERLICH

RheinMain University © Prof. Dr. Stephan Bohm
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Mobile App Development: IT Service Provides

Depending on the specific requirement criteria the app development can be
provided by different IT service providers.

or SCUss,o
Agency House Integrator

Project budget Medium High Very high

Complexity Low Medium High Very high

Life span Short Medium Medium Long

Design requirements Medium High Medium Low

Security requirements Low Medium High High

Business criticality Low Medium High High

RheinMain University Prof. Dr. Stephan B6hm
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Mobile App Development Costs: Categories

Development costs vary depending on the platform - programming and
debugging account for about half the cost.

Table: Mobile application development costs

- ' Deseription | Average cost to develop an app for 95% of apps excluding those with highest deviopment time (n=1,510)
Tools Computer cost, developer registration fees and tools licenses.
" Development&  The bulk of app production costs (upwards of 55%).. Practically speaking, the
| Dobugg! | cost of person-hours devoted to the project. | S0 $5,000 $10,000 $15,000 $20,000  $25,000 $30,000
| UX design | Storyboards, user interaction and graphic design typically make up 25% of |
| | total app cost. | Android 522,637
Maintenance Typically 10% of the initial app cost, on an annual basis

Marketing ‘We estimate that marketing costs average 10% of app production expenses. In BlackBerry OS 315,181

practice, marketing costs differ based on the developer segment — Hobbyists
| and Explorers will use Facebook as the lowest hanging fruit, whereas Hunters

- will use more sophisticated and premium channels such as professional PR 108 $27463

serviees and incentivised downloads.

Back-end costs vary depending on the application’s requirements — from | Windows Phone
lightweight (user management services on Appcelerator, Spire.io or
Parse.com) to heavy (applications written from seratch on Amazon Web

Services (AWS) or Google App Engine).

Back-end

Source: Developer Economics 2012 | w

Souree: VisionMobile Licensed under Creative Commons Attributic

mics.com | June 2012 o i 4
moaie  BlueVia

Source: http://www.visionmobile.com/product/developer-economics-2012/

. . . : © Prof. Dr. Stephan B6hm
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Mobile App Development Costs: iBusiness Study

In Germany, average development costs of 7,800-49,000 EUR were identified
— the cost vary based on the complexity of the app.

iBusiness study on app development costs in 2013

= Survey of agencies and design studios in Germany

= Average cost depends on the complexity:
— Simple app: 7,754 EUR
— Medium complexity ("Where-is-my-car-app"): 13,397 EUR
— High complexity: 48,804 EUR

= A major cost driver: front end/back end development

= Additional costs for second platform: 58%

= Costs for iOS / Android now aligned

=  Symbian apps cost 45% more - Windows Phone currently the most expensive

Source: http://business.chip.de/news/Mobile-Apps-Alleskoenner-kosten-50.000-Euro_64005338.html

. . . : Prof. Dr. Stephan B6hm
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Mobile App Development Costs: Costs Calculator

First indications of the expected costs for an app development can be
derived from online calculators.

Y
l'l
Totals
Camera  Photos 6,000
Dashboard 6,000
E-mail Login 1,500
Custom User Interface 12,000
Total $25,500

Save Quote
E-mail Me My Quote

eeeeeeeee Quete URL

Example: Otreva App Cost Calculator

(Source: http://www.otreva.com/calculator/# )

RheinMain University © Prof. Dr. Stephan Bohm
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Development Approach

It is important that the app development follows an user-centered approach,
i.e. is taking the earliest possible involvement of end-users.

Past:
Waterfall Model
(i.e. Royce 1970)

sssssssss

Innovate /\]
’ Validate
( ‘\‘ \UJ
</ \ .
esign
TOday: ‘ Centered ,.@‘:‘::)m
. D - valuate
User-Centered Design Undorstand osion § N\~
. sers "-"".
(i.e. 1SO 9241, SAP) £ -’
- [ )
Define
Interaction
Source of pictures: http://projectcommunityonline.com/wp-content/uploads/2012/06/developmentprocessl.gif,

http://www.sapdesignguild.org/editions/edition10/ucd_overview.asp

RheinMain University © Prof. Dr. Stephan B6hm
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User Centered Design Approach

The design & development approach within UCD relies on prototypes to gather
user feedback and stepwise improve the app concept.

3
? Design & Development

1 2
.. - . Market
Initial Ur:JZr;nt Require- Proto- Implemen- —
Assessment ments type tation .
Research duction

_____________________________________

RheinMain University Prof. Dr. Stephan B6hm
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Idea Generation

Idea generation has to be conducted before the development process can
begin — features and functions can be defined using creativity techniques.

- Brainstorming - -
= C .,

Source: Projekt HSRM/CSC

RheinMain University © Prof. Dr. Stephan B6hm
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Competitive User Experience Analysis

Based on these ideas a competitive analysis from the user's perspective
should follow ("Competitive User Experience").

Advantages of a “Competitive User Experience” Analysis

% |dentification of best practices and user expectations

Focused

(established functions and design elements) CHOW
% Avoid mistakes of others i dishela_

(problem areas of existing solutions) goodrec |
= Better adaptation to user needs —

(Identification of opportunities and "niches") _— —

@ Citysearch

& |nspiration/identification of emotional elements
("Emotional Design")

FIGURE 5.1 Two-by-two diagram for Foodspotting (Courtesy of Alexa Andrzejewski)

Source: Susanne Ginsburg, Designing the iPhone User Experience

RheinMain University Prof. Dr. Stephan B6hm
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Up-front User Research

In further steps customer requirements are to collect by up-front user
research — this is not to be confused with a usability testing.

Up-front user research: Informs product requirements and design

“What should we design?”

ESWE Verkehr
Tarifcheck

Bitte wahlen Sie den gewiinschten

Usability testing: After requirements defined and initial design established

“Did we design it right?”

Source: Ginsburg 2010

* RheinMain University © Prof. Dr. Stephan Bohm
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Book Recommendation: Mobile App Design

Designing the iPhone User Experience:
A User-Centered Approach to Sketching
and Prototyping iPhone Apps

by Suzanne Ginsburg

Paperback: 336 pages

Publisher: Addison-Wesley Professional
1 Edition (August 22, 2010)

Language: English

ISBN-10: 0321699432

* RheinMain University
of Applied Sciences

IPhone

User Experience

A User;Centered Approach
to Sketching and Prototyping
iPhone Apps

Suzanne Ginsburg

© Prof. Dr. Stephan B6hm
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Methods for Up-front User Research

A variety of tools are available to conduct up-front user research and to
document the findings of this process.

User Research Methods:
Shadowing (Context Analysis),
Field Interviews, Diary Studies

- v dassroom

her 2:00 p.m. class is held in

. | Marta's sophomars year o 0. She just finished aatin, tunch
User Research Analysis & |~ et g o
\ p 3 4; P the night befora,
Documentation: - ' i
Personas, Szenarios, Use Cases, ; o, | e
User Journeys B ' -

the Puck Building. Although Martz

classes at Puck. She

- £oes to the NYU weh

ite isn't farmatted for the device. After sev;::e
Marta finally finds tha building. It's not linked to
&5 the cross streats before exiting Safari,

P miake Marta's life eassary Marme: Marta, Callege
Sophomare

Source of pictures: http://www.facit-digital.com,
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http://www.system-concepts.com, Suzanne Ginsburg 2010
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Prototyping

The concept can then be tested based on prototypes to determine its
suitability with users and to be further improved.

Konzeption/Prototypen

RheinMain University © Prof. Dr. Stephan B6hm
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Prototyping Types

Based on the development phase low- and high fidelity prototypes are used.

Low-fidelity/Paper Prototypes Low-fidelity Prototypes/Wireframes
(e.g. Forms, Stencils) (e.g. Balsamiq)

High-fidelity/Click-Prototypes
(e.g. Axure)

MOVIES

THEATERS

. MY ACCOUNT

Source of pictures: http://uxpin.com/mobile-kit-for-iphone.html, http://www.uistencils.com/products/iphone-stencil-kit,
http://builds.balsamig.com/b/mockups-web-demo/ , http://www.axure.com/learn/iphone-app/template

RheinMain University © Prof. Dr. Stephan Bohm
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Video Prototypes

Mobile app concepts can be presented very clearly to users and decision
makers in demo videos — or so called “video prototypes”.

Han dly ng

Pengjg
" auf S
Haltes,e”e dem Weg Preche,

Dan
v €S Mohi .

begeiny 1S Seit epr €1t an g
- - Eilnimp, " h
| INNOVATION,
+ Sp
FUR VERKepgo ENZIALE ‘
rey
keh,

EHRSBETRIERE B

»

y

‘l

4

Link to video example: http://www.csc.com/de/offerings/64514/70102-mobile_loesungen_im_oeffentlichen personenverkehr
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Methods for Up-front User Research

» Low-fidelity Prototyping: r e\
: : : o e
(1) High Ilevel of abstracftlon from screen design lm., \Mﬁ
2 ' : B — |
(2) No colors, pictures, fonts, etc b ]?
(3) Use of wireframes, placeholders, etc. 1w
(4) Paper based, software based, hybrid e

» High-fidelity Prototyping:

(1)  Design is very close to the end product °

(2)  Usage of colors, pictures, fonts, etc.

eeeeeeeeeeeeeeeeeeeeeeeeeee

(3)  Picture- (e.g., InVision) or code-based (e.g., Codiga)
(4) Software based

\\\\\\\\\\\\\

Quelle: Ginsburg (2010)
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Prototyping Tools (Low-Fidelity, POP)

BHPGP

Foastures  Pricing  Sketchpad  Support -

Have an app idea?
Make this real, with POP.

Whether you're a student, a designer, or an entrepreneur,
POP helps you transform your pen + paper ideas into a real
working prototype

® App Store » Google play

R [IERR 5l o rwost Bz | o #oiom Gaemcpor
—

ya v

- P
-

o

\

28

b
|

% :

» ."4

>

-
-

t A

o

https://popapp.in/
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Prototyping Tools (Low-Fidelity, Balsamiq)

Projecx Edit View Help Web Demo Project

=. L[ &= (] £ Quick Add HOeE O

All Assets Big Buttons Common Containers Forms lcons 05 Layout Markup Media Symbaols Text

Alert Box 05 Keyboard 05 Menu 05 Picker iPad iPhone ON, OFF Switch Pointy Button

Popover

Mockups 0= < Welcome

-

MNotes

This is a sample project to help
you learn your way around.

Feel free to delete it or use some of
these controls for your own
projects.

Welcome

-\\ Mockups 5 Easy

i g s el
[E=e ey -

R E If you want to save your data,
o= Welcome to Balsamiq MockuU| osunisad e project s
;:__'.ﬂ S (from the Project menu) and open it
et = in Mockups 3 for Desktop.

Adding controls df— Start here!

Altermate Versions [? —+

Click the '+' to create an alternate

Desktop example

version of this mockup.

CETTY

http://webdemo.balsamig.com/

. . . : © Prof. Dr. Stephan B6hm
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Prototyping Tools (High-Fidelity, Codiqa)

Pages + 0 o Page @ L]
Class
Examples
Platforms . Title | Home
codiqa o ,
Swatch SIEENE
. Background | chogse image. —
Welcome to Codigal Image = - 00SE IMAge..
Try dragging some elements from the Backglround No repeat ¥
left over here. Repent
Components &
You can also add pages, and link Content | 4z
buttons to them, like below! Padding —T
= o
This is just a simple demo, upgrade to 14 | paget —
Page Header Page Footer Tab Bar the full version to get a lot morel
Nav Bar Button Link
Panel Ir".agr: YouTube
@ H1H2 ua
v ' -
Vimeo Map Heading Components
Code

https://codiga.com/demo
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Prototyping Tools (High-Fidelity, Fluid)

(@)
fLUId Features Use cases

Design brilliant apps

Then share them online for feedback or

preview them on your mobile.

\

Try it free

https://www.fluidui.com/

* RheinMain University
of Applied Sciences

Demos

Plans

Sign in

Sign up free
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Prototyping Tools (Low-Fidelity, Proto.io)

proto.lo New features ~ Tour  Customers Demos Learn Pricing Blog  Signin | Sign Up Free

Groups, Layers and
Multi-item edit

Speed up and organize your work
beautifully, in nested groups.

Read more

https://proto.io

© Prof. Dr. Stephan Béhm

* RheinMain University
of Applied Sciences 48


https://proto.io/

Prototyping Tools (Low-Fidelity, InVision)

mIISIOn TOUR CUSTOMERS NEW FEATURES ENTERPRISE BLOG LOGIN

DESIGN BETTER. FASTER. TOGETHER.

The world's leading prototyping, collaboration & workflow platform

GET STARTED — FREE FOREVER!

http://www.invisionapp.com/

RheinMain University © Prof. Dr. Stephan B6hm
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Business Model

If a commercialization of the app is intended, the business model must be
specified prior to its distribution.

Important Business Models for Mobile Apps

Business Model | Description and Characteristics

Paid App Download the app for a purchase price

InApp-Purchase  Payment for additional features or content

Freemium Free basic version and paid extensions

Virtuelle Goods  Paid "consumer goods" (e.g. currency for a mobile game)
Subscriptions Time-recurring payments for use

Advertising Integration of paid advertising

Mroz (2013): App-Marketing
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Upload in the Store: Review Process

In order to be able to publish the app in the App Store of the platform the
relevant requirements and design guidelines have to be considered carefully.

http://developer.android.com/distribute/googleplay/publish/console.html

Developers ~

Google Play >

Publishing ~ iTunes Connect Developer Guide
Once you've registerel .

Get Started Table of Contents

Developer Console
Localization Checklist

Launch Checklist

Promoting v = Allappheations Creating an iTunes Connect iTunes Connect is a suite of web-based tools created for developers to submit and manage their apps for sale in the
_ Record for an App Store. This document describes how to use iTunes Connect before, during, and after submitting an app for distributidg
App Quality v S. Financial reports
= Configuring Store
Policies v L3 Settings Technologies (Optional) -
Enroll in Program
' Announcement * Displaying on the Store in
Spotlight v More Than One Language .
(Optional) Develop & Test |
Google Play for v
Education * Submitting the App
Create iTunes Record
o * Setting Up User Accounts

Open Distribution - .

All applications page:C  * Viewing and Changing Your Submit App |

app. App’s Metadata - i

» Viewing and Changing Your ) 0 Release App
Your account det App’s Status and
The account details p ST ) @ M
ici i » Transferring and Deleting You are here

Design Develop

Qi

L

Developer Coi D iI0S Developer Library

will be the home fory
key areas you'l find ir

F, Google play

Introduction

v

Owerview of iTunes Connect

v

First Steps: Identifying Your
App in iTunes Connect

hasicinfarmationaly

RheinMain University

of Applied Sciences

Apps
Improving Your Customers”’
Experience

v

* Replacing Your App with a

About iTunes Connect

iTunes Connect organizes your portfolio of store content, legal and tax documents, and contact information so that

to the material. iTunes Connect also collects status information, feedback, and earnings information that comes fromn

New Mersion,

https://developer.apple.com/library/ios/documentation/LanguagesUtilities/Conceptual/iTun
esConnect_Guide/Chapters/About.html#//apple_ref/doc/uid/TP40011225-CH1-SW1

© Prof. Dr. Stephan B6hm
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Upload in the Store: Required Items and Content

For the distribution in the App Store different information needs to be
provided depending on the platform.

Important Information for App Store Upload Q<
Hessen-Statistiken
" App name HESSISCHES STATISTISCHES LANDESAMT
. OFFNEN
" Choice of category Fiir Telefone entwickelt DEINSTALLIEREN
=  Keywords for the app-description g

=  App Description — 1; é IIII —=

Icon, Logo, Graphic Feature AT

=  Screenshots

2 1| Geben Sie zuerst +1!

= Demo Video (optional)
App bewerten

n ricing model
pricing % K K K K

= Administrative information

Beschreibung

=  App software (such as APK file on Android)

Wo ist die Bevilkerungsdichte in Hessen am héchsten, welche Region ist bei
Hotelgasten am beliebtesten oder wie verteilen sich die Stimmen der hessischen
Wabhler in den einzelnen Landkreisen? Suchen Sie Zahlen und Statistiken fiir

© Prof. Dr. Stephan B6hm
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Elements of a Mobile App Distribution Strategy

In addition to publication in the App Store a comprehensive distribution
strategy need to be defined — even a good app does sell "automatic".

Important elements of a Mobile App Distribution/Marketing Strategy

m Description an Characteristics

Timing Strategy Scheduling of launch and updates

Pricing Policy Price levels and price changes

Customer Relations App website and dealing with reviews/feedback
Public Relations Communication on public relations and social media

Cross Promotion Advertisement on website, flyers, products, etc.

Mroz (2013): App-Marketing

. . . ] Prof. Dr. Stephan B6hm
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Performance Measurement

Also important is a continuous performance measurement and monitoring of
user feedback / reviews.

http://www.distimo.com

DISTIMO

Analytics ApplQ API Resources

Conversion tracking

Leaderboards App Trends Publications Press Blog

Flters @& Territo nited States X Contem An Aop X Clear A
s () ritory » U tate ontent v Aop she WhatsApp Inc.
Open in store

Unts © Price: Free

an 01, 2014 to Jan 15, 2014 I-SOM * 30% m ua AnDpe v
Overview

1 November, 2010
By Termory By Parform By Category By Content Type By Transacrion Type

Ol
e apptweak REPORTS TOPAPPS PUBLISHERS BLOG  ABOUT SIGN UP
Units per Day

Daily device install estimations over the last 4 weeks

—
Type the app name here.. @ iPhone  iPad  Google Play

08 - Filters H B . -

' = = Reviews Order. Worst reviews & ratings for - .~ =t /.
~—— —— .

" e e ,/ Worst -

4 e ————— [ 25 Sep. 2011 by miss anthrop

\ Version: @ Latest © A o n

- Wenig nuetzlich...

Unuebersichtiich, aliein der Fahrplan Linje 6 bestent aus 27 Seiten.

» . B4 ‘ ) ‘) . 7 B 22 Oct, 2011 by Busfahrer101
Sinnlos
Lohnt sich nicht bricht andauernt ab es gibt bessere funkiionen die die einbauen konnten wie zb. Erfnnerurléﬁ 5 min
vorher das der bus an meiner hs vorbel fahrt usw. Aber hauptsache ne eswe app auf dem markt bringen [l

910 Jan, 2013 by Chris-4284

Die Bezeichnung "Live Ticker" ist ein Witz. Aktuelle Meldungen gibt es so gut wie nie, lediglich Hinweise auf lange
bekannie Behinderungen wie Baustellen oder StraBenfeste. Der Fafuplan ist umstandiich zu bedienen und igdf sehr
Isngsaim.

Territory Platform Wich gste Funktion fehlt! ) )
Gibt leider keine fahrplanauskunit! Bleibe bei meiner anderen app - wird geiéscht!
] I, 12 Jul, 2013 by liio
1
= ouark
|

. [ 28 Feb, 2014 by Pet Kopenhagen
Apple iTunes Connect T ————

https://www.apptweak.com
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